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1. Overview:

1.1. About this document

This document is intended to be a comprehensive reference for all D-RATS features and is based on D-RATS
version 0.3.0.

An Adobe Acrobat version of this document can be downloaded from: http://www.d-rats.com/download/doc/D-
RATS_User_Manual.pdf

1.2. About D-RATS

D-RATS is a communications tool for D-STAR low-speed data (DV mode). It provides:

1. multi-user chat capabilities;

2. structured data transport (forms); and

3. position tracking and mapping.

2. Installation:

The latest release version of the D-RATS program can be downloaded from http://www.d-rats.com/wiki/Down-
loadPage

D-RATS can be installed on MS Windows, Linux, or MacOS X computers using the following Installation Guide.

3. Configuration:

3.1. Application Settings

3.1.1. User Settings

Prior to utilising D-RATS there are a number of preferences that must be configured. These can be accessed by
selecting File > Preferences:

http://www.d-rats.com/download/doc/D-RATS_User_Manual.pdf
http://www.d-rats.com/download/doc/D-RATS_User_Manual.pdf
http://www.d-rats.com/wiki/DownloadPage
http://www.d-rats.com/wiki/DownloadPage
http://www.d-rats.com/wiki/wiki/InstallPage#
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A list of configurable items will appear in the left hand column.

The options are:

• Callsign: This should be your exact callsign, nothing else. This is prefixed to outgoing messages for identifi-
cation.

• Name: This is your familiar name (Not currently used).

• Sign-on Message: If enabled, the message in the box will be transmitted upon starting D-RATS.
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• Sign-off Message: If enabled, the message in the box will be transmitted upon exiting D-RATS.

• Units: Select between Imperial (default) and Metric.

• Show time in UTC: If enabled, displays time in UTC, rather than local time.

• Ping Reply: This message will be sent to any D-RATS station that pings your callsign.

• Language: Select between English (default), Italian and Dutch.

• Blink tray on:

• Incoming Messages: If enabled, this will cause the D-RATS icon, in the system tray, to blink on receipt of
an incoming message.

• New Chat Messages: If enabled, this will cause the D-RATS icon, in the system tray, to blink on receipt
of new chat messages.

• Incoming Files: If enabled, this will cause the D-RATS icon, in the system tray, to blink during receipt of
an incoming file.

• Received Events: If enabled, this will cause the D-RATS icon, in the system tray to blink when an event
is received.

3.1.2. Path Settings

The options are:

• File Transfer Path: Set to the desired location as to where downloaded files and files available for upload
are to be stored.

• Map Storage Path: Set to the desired location as to where downloaded map files, from the internet, are to be
stored. This can be a shared directory, if multiple computers running D-RATS wish to share map files.
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3.1.3. GPS Settings

The options are:

• Latitude: This should be the latitude coordinates of your station. It should be in decimal degrees or De-
grees-Minutes-Seconds format (use the space bar to substitute for the degree, minute, and second symbols).
Use (-) for latitudes south of the equator.

• Longitude: This should be the longitude coordinates of your station. It must be in decimal degrees or De-
grees-Minutes-Seconds.

• Lookup by address: This option allows you to determine your approximate coordinates from your street address
if the computer is connected to the internet.

• Altitude: This should be your station's altitude above sea level.

• External GPS: If utilised select the Com port and port speed of an externally connected GPS.

• Use External GPS: If enabled, instructs D-RATS to use coordinates provided by an external GPS.

• Table: Table sent as part of a GPS-A message.

• Symbol: Symbol sent as part of a GPS-A message.

• Freshen Map After: Determines how frequently D-RATS should check the internet for updated maps (default
= 720 hours).

Note: The position shown in the User Manual is in Australia and has negative latitudes and positive longitudes.
Positions in the U.S. have positive latitudes and negative longitudes. For example, the center of the U.S. is 37.7500
latitude and -99.5000 longitude.
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3.1.4. Appearance Settings

The options are:

• Notice RegEx: A regular expression describing strings to highlight (see explanation below).

• Ignore RegEx: A regular expression describing strings to "dim". (see explanation below).

• Incoming Color: This controls the color of the text received from other stations.

• Outgoing Color: This controls the color of messages you send.

• Notices Color: This is the highlight color for strings matching the Notice RegEx.

• Ignore Color: This is the dim color for strings matching the Ignore RegEx.

• Broken Color: This is the color used to highlight raw text received that can't be checked for validity (if enabled)

http://www.d-rats.com/wiki/wiki/RegEx#
http://www.d-rats.com/wiki/wiki/RegEx#


UserManual

7

3.1.5. Chat Settings

The options are:

• Log chat traffic: If enabled, a "drats.log" file will be generated in your download directory and will log all
chat traffic.

• Load log tail: If enabled, loads the tail of the chat log from the last session.

• Chat font: The font for the main window chat display.

• Scrollback lines: Defines the number of lines available for scrollback in the chat display (default = 1024).

• Show status updates in chat: If enabled, displays any status updates in the chat display.
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3.1.6. Sounds Settings

The options are:

• Chat activity: If enabled, the location and filename of sound to play if any chat messages are received.

• Message activity: If enabled, the location and filename of sound to play if any messages are received.

• File activity: If enabled, the location and filename of sound to play if any files are received.
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3.1.7. Radio Settings

D-RATS can be configured to operate simultaneously across multiple communication links, eg: 2m, 70cm, 23cm
and the internet.

The options are:

• Enabled: If enabled, this port is active and available for use with D-RATS.

• Port: The device to open. Enter the desired port to operate across (i.e. "COM14", "/dev/cua0", or "net:ref.d-
rats.com:9000").

• Rate: The data speed used to connect D-RATS to your radio. This must match your radio (see table below.),
but has no bearing on "net:" type connections such as the Ratflector.

Radio Rate Radio settings required for D-
RATS to function

IC-80AD 9600 DATATX = AUTO, GPS-TX =
OFF, GPS.ATX = OFF

IC-U82 9600 ATX = ATXON, SPD = SPD96

IC-V82 9600 ATX = ATXON, SPD = SPD96

IC-91AD 38400 DV DATA TX = AUTO, GPS TX =
DISABLED, GPS AUTO TX = OFF

IC-92AD 38400 DV DATA TX = AUTO, GPS TX =
DISABLED, GPS AUTO TX = OFF

IC-2200 9600 ATX = ATXON, SPD = SPD96
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IC-2820 9600 DV DATA TX = AUTO, GPS TX
= DISABLED, GPS AUTO TX =
OFF, UT123 must be installed

ID-800H 9600 DVT = DVTAT, SPD = SPD96

ID-880H 9600 DATATX = AUTO, GPS-TX =
OFF, GPS.ATX = OFF

ID-1 19200 Unknown

Ratflector not used Not applicable

• Ratflector password: Optional password to send if required to access a Ratflector (default = no password).

• Sniff packets: If enabled, log some information about packets seen that are destined for other stations.

• Receive raw text: If enabled, displays all text received in the chat window.

• Name: A descriptive name for this entry. It will be displayed in other parts of the program.

3.1.8. Transfers Settings

The options are:

• Block size: The largest amount of data that is covered by a single checksum. The larger this is, the more efficient
the transfer is on a good connection. On a bad connection, setting this to be smaller reduces the amount of data
that must be re-sent in the event of a bit of corruption. Revert resets value to default settings.

• Pipeline blocks: The number of blocks (of Block size bytes) that are sent each round. Revert resets value to
default settings.

Be aware that ‘Block size’ times ‘Pipeline blocks’ can cause a transmission time long enough to time out radios
and/or repeaters. Larger is not always better.
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• Remote form transfers: If enabled, allow remote users to retrieve forms from this station

• Remote file transfers: If enabled, allow remote users to retrieve files from this station's File Transfer Path
directory.

3.1.9. Tuning Settings

The options are:

• Warmup Length: The number of bytes to prefix to each packet after a period of idle. This may help to "warm
up" a handheld radio on the receiving end that is in power save mode. Revert resets value to default settings.

• Warmup timeout: The number of seconds between transmissions that is considered to be "idle", thus causing
the next transmission to include the prefix pad, as described above. Revert resets value to default settings.

• Force transmission delay: Always wait this many seconds before transmitting a packet. Revert resets value
to default settings.
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3.1.10. TCP Gateway Settings

The options are:

• Port: Receive traffic on this port from stations over the radio link (i.e: port 25).

• Host: Send traffic to the designated port at the host address (i.e: mail.foo.com).
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3.1.11. TCP Forwarding Settings

The options are:

• Local Port: Listen for connections to a designated port on the local machine (i.e: port 2525).

• Remote Port: Send data received on that port (i.e port 2525) to the designated port on the remote machine
(i.e: port 25).

• Station: Address this data to the callsign entered across the radio link.
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3.1.12. Outgoing Email Settings

The options are:

• SMTP Server: Address of the remote SMTP server to send outgoing email (i.e smtp.gmail.com).

• Port and Mode: Port that the remote SMTP server expects to receive email on (i.e gmail uses port 587 and
TLS enabled).

• Source address: Default email address to use on outgoing email.

• SMTP Username: Username to log into the remote SMTP server.

• SMTP Password: Password to log into the remote SMTP server.

• Gateway: If enabled, allows email received from D-RATS to be sent to the internet.
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3.1.13. Incoming Email Settings

The options are:

• Server: Address of the remote POP server to receive incoming email (i.e pop.gmail.com).

• Username: Username to receive incoming email.

• Password: Password to receive incoming email.

• Poll Interval: Frequency (in minutes) to see if new email is waiting on the remote POP server.

• Port: Set to the port that the remote POP server expects to receive email on (i.e 110. pop.gmail.com uses port
995).

• Use SSL: If enabled, connect to the remote POP server with SSL.

• Action: Treat the email as a Form or as a Chat message (default = Form).
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3.1.14. Email Access Settings

The options are:

• Callsign: Enter the callsign of a D-RATS user that you wish to process email for.

• Access: Determine how email will be handled for the nominated callsign, eg: None, Both, Incoming, or Out-
going.

• Email filter: Looks for a string matching this field in the message, so that it can direct the message to the
nominated callsign.

3.2. QST Settings

D-RATS allows an automatic message to be broadcast at a specified interval. The message can be text specified
by the user, the output of a program, a text file, or GPS coordinates.
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3.2.1. Viewing existing QST beacons

1. Go to the Chat tab and select QST.

2. QSTs that are currently being used have the On box ticked.

3. The time remaining until the next QST is displayed for each message.

3.2.1.1. Adding / Editing a text QST beacon

1. Click on the Add or Edit button as appropriate.

2. Make sure the message type is set to Text.

3. Set the interval in the drop-down box (the default is 60 minutes). Preset intervals include 1, 5, 10, 20, 30, or 60
minutes, and 15, 30 and 45 minutes past the hour. Use a preset interval, or manually type one in the box (i.e.,
15 for every 15 minutes, or :25 for 25 minutes past the hour).

4. Type your message in the bottom box.

5. Click OK.

3.2.1.2. Adding / Editing a QST beacon containing GPS coordinates

Note: Your GPS coordinates must already be configured in D-RATS. See GPS Tracking.
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1. Click on the Add or Edit button as appropriate.

2. Set the message type to GPS.

3. Set the interval in the drop-down box.

4. Type a short message in the bottom box.

5. Click OK.

3.2.1.3. Adding / Editing a QST beacon in GPS-A format

Note: Your GPS coordinates must already be configured in D-RATS. See GPS Tracking.

1. Click on the Add or Edit button as appropriate.

2. Set the message type to GPS-A.

3. Set the interval in the drop-down box.

4. Type a short message in the bottom box.

5. Click OK.

3.2.1.4. Adding / Editing a QST beacon from Weather Underground

1. Click on the Add or Edit button as appropriate.

2. Set the message type to Weather (WU) and then browse to the file.

3. Set the interval in the drop-down box.

4. Select whether the WU source is from an airport or a personal weather station.

5. Enter the WU station identification.

6. Click OK.

3.2.1.5. Adding / Editing a QST beacon from a RSS feed

1. Click on the Add or Edit button as appropriate.

2. Set the message type to RSS and then browse to the file.

3. Set the interval in the drop-down box.

4. Enter the URL of an RSS feed in the botton box.

5. Click OK.

3.2.1.6. Adding / Editing a QST beacon from a CAP feed

1. Click on the Add or Edit button as appropriate.

2. Set the message type to CAP and then browse to the file.

3. Set the interval in the drop-down box.

4. Enter the URL of a CAP feed in the botton box.

5. Click OK.

3.2.1.7. Adding / Editing a QST beacon from a text file

1. Click on the Add or Edit button as appropriate.



UserManual

19

2. Set the message type to File and then browse to the file.

3. Set the interval in the drop-down box.

4. Click OK.

3.2.1.8. Adding / Editing a QST beacon from the output of an executable file

1. Click on the Add or Edit button as appropriate.

2. Set the message type to Exec and then browse to the executable.

3. Set the interval in the drop-down box.

4. Click OK.

3.2.2. Deleting a QST beacon

To delete a QST beacon:

1. Go to the Chat tab and select QST.

2. Click on the QST that you wish to delete, so that it is highlighted.

3. Click the Remove button.

4. Confirm whether you really wish to delete the QST.

3.3. Quick Message Settings

Quick messages are pre-canned messages that can be sent with (almost) a single-click.
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3.3.1. Setting a Quick Message

1. Go to the Chat tab and select Quick Messages.

2. Enter a message in the text box.

3. Click OK.

3.3.2. Deleting a Quick Message

1. Go to the Chat tab and select Quick Messages.

2. Click on the Quick Message that you wish to delete, so that it is highlighted.

3. Click the Remove button.

4. Confirm whether you really wish to delete the Quick Message.

4. Using D-RATS:

4.1. The D-RATS Main Window

The D-RATS main window has been broken up into several sections, comprising:

1. Toolbar (at the top of the screen) with options including File, View and Help;

2. Tab entries for Messages, Chat, Files and Event Log;

3. Stations window that displays a list of callsigns seen by D-RATS; and

4. My Status window indicated whether you are online and available.

4.2. The Stations Window

The Stations window (located on the right hand side of the D-RATS program) is used to display a list of stations
that have been received by D-RATS and their status.

When-ever a D-RATS station transmits any sort of message (Going online, positional information, QST Beacon,
chat message, file transfer, etc) their status is sent to all stations using the same port (i.e: RF, Ratflector, etc).

Callsigns, in the Stations List, that are:

• Blue - Currently online and responding.

• Black - Not responding.

• Dimmed - have been previously received, but sent a "Sign-Off Message" and are therefore no longer accessible.

4.2.1. Checking the Status of an specific station

1. Right click on the callsign of interest in the Stations window. A sub-menu will be displayed.

2. Click on Ping. A Ping request will be sent to the desired callsign and if they are on-line the last-heard timer,
next to their callsign, will revert to zero.

3. By performing a mouse hover over their callsign, their status and other information will be displayed.

4.2.2. Finding out who else is on-line and their status

1. Right click somewhere in the Stations window. A sub-menu will be displayed.
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2. Click on Ping All Stations. A Ping request will be sent to all enabled ports (i.e: RF, Ratflector, etc) and all
stations that are on-line will respond.

3. By performing a mouse hover over their callsign, their status and other information will be displayed.

4. If a previously pinged station does not respond their last-heard time will not revert to zero.

4.2.3. Requesting positional information for a remote station

1. Right click on the callsign of interest in the Stations window. A sub-menu will be displayed.

2. Click on Request Position. A position request message will be sent to the desired callsign and if they are on-line
and have their coordinates configured in File > Preferences > GPS then their Latitude and Longitude details
will be broadcast to all connected stations.

4.3. The My Status Window

The My Status window displays the current status of your station and the Sign-On message that will be sent to
other stations.

4.3.1. Changing your Station's Status

1. When-ever your station is pinged by another station, or your station transmits information for any reason, the
Status information will be sent.

2. Use the drop-down list to select between Online and Unattended.

4.4. The Messages Tab

The Messages tab opens the Messages Window where internet email and forms can be exchanged across D-RATS.

D-RATS supports a number of different types of forms, such as HICS260, ICS213 and email, that are packaged
and distributed with the D-RATS program and these function in the same manner to that of an email message.
Some of these messages can auto populate appropriate fields simplifying data entry.

Currently email and forms sent / received via D-RATS is limited to text. D-RATS cannot process images, attach-
ments, or html coding.

4.4.1. The Messages Toolbar and Window

The Messages Toolbar advises what options are available.

• New: Allows a new Email message or Form template to be opened.

• Send: Allows a message in the Inbox to be sent to another Station in the Station's list.

• Reply: Reply to the highlighted message.

• Delete: Delete the highlighted message.

• Mark Read: Mark the highlighted message as Read.

• Mark Unread: Mark the highlighted message as Unread.

Folders depicting Inbox, Outbox, Sent and Trash are available to be clicked on. If an item is displayed in the
Outbox, it indicates that the message has not yet been sent.
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4.4.2. Receiving Email and Forms through D-RATS

1. Double clicking on a received email/form will open the item for display and provide several options on what
to do with it.
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4.4.3. Sending Email and Forms through D-RATS

1. Click on the New button and select the desired item from the drop-down list. Some examples of forms currently
distributed with D-RATS are:

1. To send an email message, select email from the drop-down list.

2. Enter the email address of who the message is from in the From field.

3. Enter the destination email address in the To field.

4. Enter the message subject in the Message field.

5. Enter the message content.

6. If sending this message through a D-RATS Gateway station, click on the Path button and enter the callsign
of the Gateway station.
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7. When creation of the message is completed, click on Save.

8. The message will be saved in the Outbox awaiting further action.

9. Highlight the desired message that you wish to send and click on the Email button.

Note: Content of messages / forms transmitted across RF via D-RATS are subject to the usual regulations and
where appropriate 3rd party agreements. Due care should be taken to ensure that messages / forms do not breach
these rules and agreements.

4.5. The Chat Tab

The Chat tab opens the Chat Window where information can be exchanged in real-time with other D-RATS users
and where QST beacons can be managed.

4.5.1. Chatting in Real Time

1. From the main window, select the Chat tab near the top of the screen.

2. If you have multiple ports configured, select the appropriate port you wish to send the message through.

3. Enter your message in the box and click Send.

4.5.2. Sending a Quick Message

1. Go to the Chat tab and select Quick Messages.

2. Choose which port you wish to send the message on.

3. Double-click on a message from the list to send it.

4.5.3. Forcing QST beacons to be sent

To immediately send a QST:

1. Go to the Chat tab and select QST.

2. Ensure that the On box is ticked for the desired QST.

3. Double-click on its entry. This also resets the timer.
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4.6. The Files Tab

The Files tab opens the Files Window where files can be exchanged across D-RATS.

It should be remembered that D-RATS operates across the low speed data segment of a D-STAR digital voice
transmission and that the file speed is less than 1kbps. Therefore it would be unwise to attempt the transfer of
large files across D-RATS.

4.6.1. Testing Connectivity with a Remote Station

Unlike the D-STAR DV Voice Channel, which has error correction built into the protocol, the Data Sub-channel
has no error correction. This makes the transfer of data across D-STAR a lot more dependant on a good radio path
being established between the two locations wishing to exchange data.

D-RATS includes the ability to test connectivity between two locations.

1. Click on the Files tab to display the Files window. (Note: This process can be performed through any of the
windows.)

2. Right click on the callsign of interest in the Stations window. A sub-menu will be displayed.

3. Click on Test Connectivity. Details of the desired station to test with shall be displayed.
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1. If correct, Click on Forward.

2. Confirm the test parameters.

1. Click on Start.

2. The test will conclude advising the quality of the path.

4.6.2. Send a File to a Remote Station

1. Click on the Files tab to display the Files window.
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2. Select, from the drop-down list, the Station you wish to send a file to.

3. If you have multiple ports configured for D-RATS to operate across, select the appropriate port.

4. Click on the Connect button. (If communications has been successfully established with the remote station a
list of files in their File Transfer Path directory will be displayed.)

5. Click on the filename you wish to send, so that it is highlighted.

6. Click on the Upload button. (The status of the transfer will be displayed in the bottom status bar.)

7. When the transfer is complete the filename should appear in their File Transfer Path directory.

8. Click on the Disconnect button to disconnect from the remote station.

4.6.3. Get a File from a Remote Station

The following procedure assumes that the remote D-RATS station has the Remote File Transfer box enabled in
File > Preferences > Transfer.

1. Click on the Files tab to display the Files window.

2. Select, from the drop-down list, the Station you wish to receive a file from.

3. If you have multiple ports configured for D-RATS to operate across, select the appropriate port.

4. Click on the Connect button. (If communications has been successfully established with the remote station a list
of files available (from their defined File Transfer Path directory) to be received will be displayed, including
file size and the date/time of the file creation.)

5. Click on the filename you wish to receive, so that it is highlighted.

6. Click on the Download button. (The status of the transfer will be displayed in the bottom status bar.)

7. When the transfer is complete the filename should appear in your File Transfer Path directory.

8. Click on the Disconnect button to disconnect from the remote station.
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4.7. The Event Log Tab

The Event Log tab opens the Event Log Window where a summary of recent events can be viewed.

4.8. D-RATS Mapping

D-RATS can display the location of other D-STAR users as well as information from specialist services, such as
NBDC Buoys and NWIS Rivers.
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4.8.1. Viewing the Map

1. Go to the View menu and select Map.

2. Information displayed will include the Station name and its associated latitude and longitude coordinates, as
well as the distance and direction to the station, from your location, for any positional information received
across RF or an internet connection (i.e: through a Ratflector).

4.8.2. Additional information which can be displayed on the Map

4.8.2.1. Adding Static Overlays to the Map

D-RATS can import ".csv" files containing static lists of positional information (i.e: Hospitals, Repeater Sites,
EOC's, etc) that can be displayed on the D-RATS Map. See the Map Display page for further details on creating
a static list, or the Map Overlays page for examples of some that have already been created.

http://www.d-rats.com/wiki/wiki/MapDisplay#
http://www.d-rats.com/wiki/wiki/MapOverlays#
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4.8.2.2. Adding NBDC Buoys to the Map

NBDC Buoys can be added to the D-RATS Map. If an internet connection is available D-RATS will interrogate
the NDBC web site and retrieve information pertaining to the specified buoys.

To add an NDBC Buoy to the D-RATS Map:

1. Go to the Map menu and select Edit Sources.

2. Select NBDC Buoy from the drop-down list.

3. Enter the unique NBDC Buoy identifier in the Buoys field (multiple buoys can be added separated by commas).

4. Data pertaining to the NBDC Buoy can be seen by hovering the mouse over the Buoy icon on the map.

4.8.2.3. Adding NWIS River Information to the Map

NWIS Rivers can be added to the D-RATS Map. If an internet connection is available D-RATS will interrogate
the NWIS web site and retrieve information pertaining to the specified rivers.

To add an NWIS River to the D-RATS Map:

1. Go to the Map menu and select Edit Sources.

2. Select NWIS River from the drop-down list.

3. Enter the unique NWIS River identifier in the Sites field (multiple Rivers can be added separated by commas).

4. Data pertaining to the NWIS River can be seen by hovering the mouse over the River icon on the map.

4.8.3. Printing / Saving the Map

D-RATS can print the current map screen, or save it as a "*.png" image.

http://www.ndbc.noaa.gov/
http://waterdata.usgs.gov/
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1. Go to the Map menu and select Export, followed by the desired option.

4.9. Forms:

4.9.1. Creating Form Templates

Need information here...

5. D-RATS Map Downloader:

The D-RATS Map Downloader is a separate application that is packaged with and installed as part of the normal
D-RATS installation process. It allows a range of maps to be downloaded, across the internet, for later use by
D-RATS. This is particularly useful if the computer is likely to be used away from internet connectivity. More
detailed information and configuration information can be found in the Map Display guide.

6. D-RATS Repeater:

The D-RATS Repeater is a separate application that is packaged with and installed as part of the normal D-RATS
installation process. It allows multiple D-STAR radios (even on different frequencies), that are connected to the
same computer, to interchange D-RATS information. It also allows gating of D-RATS traffic to be interchanged
between RF and internet users. More detailed information and configuration information can be found in the
Repeater guide.

http://www.d-rats.com/wiki/wiki/MapDisplay#
http://www.d-rats.com/wiki/wiki/Repeater#


UserManual

32

7. Still need to work out the best place to put this!!!

7.1. Regular Expressions

The notice and ignore functions use regular expressions for matching strings. Regular expressions are very pow-
erful, and are beyond the scope of this document. Here are a few examples to get you started:

Regular expression Explanation Will match Will not match

[Tt]esting Match any string with the
word testing

Testing, testing tesTing, besting

(bananna|apple) Match any string with ba-
nanna or apple in it

My bananna is yellow, My
apple is red

My kiwi is green

[0-9]11 Match any three digit num-
ber ending in 11

411, 911 421, 976

[0-9]{3}-[0-9]{3}-[0-9]
{4}

Match a US phone number 800-555-1212 01-423-99456, apple


